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Unit -1 

Starting MS Power point 
 

 
 

Learning objectives 
 

After the Completion of this unit you should be able to know 
 

1) What is MS Power point 2010 and what are its functions 

2) What are the components of Power point 2010 

3) The tools used in MS Power point 2010 and their use 

 
 

 Introduction 

In the earlier days people depended on transparent sheets on which they used 

to write and present it to the audience by the help of projector which was a 

very heavy machine. The main problems that arose were 

1. Writing on transparent sheets was costly and time consuming. 

2. Occupied a lot of space and difficult to transport 

3. Difficulty to update and modify with change in time 

4. Had to be kept free from moisture and heat 
 

 Definition 
 

 
 

PowerPoint is a complete presentation graphics package. It gives you everything 

you need to produce a professional-looking presentation. PowerPoint offers 

word processing, outlining, drawing, graphing and presentation management 

tools. 

Some uses Of PowerPoint 
 

1. Used to present a person’s idea within a few words and pictures. 

2. Used to describe about the project /company and its related issues. Profit making company identify 

profit /loss , purchase/sale. 

 

 

 

 

 

 

 



 

 
 
 

 Starting MS PowerPoint 2010 
 

 
 

Step-1 
 

 

 
 

Step-2 

 

 

 

 

 

 

 

 



 

1.3.1 Components of MS PowerPoint 2010 
 



 

 

 Know your tools 

 

 File Tab 
 
 

Sl.No Icon Function 

1 
 

Saves the current Power point Presentaion 

2 
 

Saves the current presentation in another 
format 

3 
 

Opens Another Presentation 

4 
 

Closes the current presentation 

5  

 

This option comprises of the following as 

shown below 

Left Side 

1. Product activation :- Whether the 

current product is activated or not 

2. Permission :-Whether anyone can 

open, change any part of the 

presentation. 

3. Prepare for sharing :-Sharing the 

power point. 

4. Versions :- Open if there were any 

earlier versions of this file 

Right Side 

Properties of the current slide 

Size Size of the File 

Slides No of slides in the presentation 

Hidden 
Slides 

No of hidden slides 

Title Title of the slide 

Tag Tags if existing 

Category Belongs to which caegory 

Last 
Modified 

Last modified when 

Created Created when 

Last 
Printed 

Last printed when 

Author Author Name 

Manager Manager Name 

6 

 

This option opens the recent files in the 

recent locations 



 

7 

 

This option creates a new presentaion 

8 

 

Prints the current presentation 

9 

 

This option is used save and send a file via 
1. Email 

2. Fax 

3. XPS 

4. Share it in the web 

5. Convert it to a PDF File 

6. Create a video file 

7. Package presentation for CD 

8. Create Handouts 

9. Broadcast slide show 

10. Publish slides 

11. Save files in different formats 

 

 Home Tab 

Once the home tab is clicked it opens up the home ribbon which is comprised of 

the following parts 
 

Clipboard 

1  This option is used to cut text or images 

2 
 

 
This option is used to copy text or images 

3 

 

This option is used to paste cut or copied 

images/text 

4 
 

Used to copy formatting from one place to the 
other 

Slides 

1 
 

 

This option is used create a new slide 

2  Change the layout of the selected slide 

3  Reset the positions ,size and formatting of the 
slide placeholders to their default setting 

4  Organize slides into sections 



 

Font 

1 
 

 
Font face 

2  Font size 

3  Make the text Bold 

4 
 

Make the text italized 

5  underline the text 

6 
 

text shadow 

7 
 

Strike thru 

8 
 

Character Spacing 

9 

 

Change case 

10 
 

 Increase the font Size 

11 
 

 Decrease the font size 

12 
 

 
Clear all formatting 

13 
 

Change font colour 

Paragraph 

1 
 

 Bullets 

2 
 

 Numbering 

3 
 

 
Decrease list level 

4 
 

 
Increase list level 

5  

 
Increase line spacing between lines in a 
paragraph 

6 
 

Align Text Left 

7 
 

Align Text Centre 

8 
 

Align Text Right 

9 
 

Justify text 

10 
 

Split the text into 2 or more columns 

11 
 

Change the text direction 

12 
 

 
Change the alignment of the text 

13  Convert text to smart art 
 



 

Drawing 

1 
 

 

Insert drawing objects 

2 

 

Arrange drawing objects 

3 
 

 

Change the visual style of the inserted object. 

4 
 

Fill the selected shape with a solid colour, 
gradient, picture or text area. 

5 
 

Change the shape effect of the inserted object. 

Editing 

1 
 

 Find the selected text in the document 

2 
 

Replace found text with another text 

3 
 

Select 

 

 

 Insert Tab 
 

 
 

Tables 

1 
 

 

Used To insert a table 

Images 

1 
 

 

Used to insert a picture 

2 
 

 

Used to insert a clip art 

3 
 

 

Used to insert a screen shot 

4 
 

 

Used to inset a photo album 



 

Illustration 

1 

 

Used to insert shapes 

2 
 

 

Used to insert smart art 

3 

 

Used to insert chart 

Links 

1 

 

Create a link to a web page, picture, an email 

address or a program. 

2 

 

Add an action to the selected object to specify 

what should happen when you click on it or 

hover over it with your mouse. 

Text 

1 
 

 

Used to insert a textbox 

2 
 

 

Insert the Header and Footer on the slide or all 

slides. 

3 
 

 

Insert a word art 

4  Insert Date And Time 

5  Insert slide number 

6 
 

 

Insert objects 

 



 

Symbols 

1 
 

 

Inserts an equaltion 

2 
 

 

Inserts a symbol 

Media 

1 
 

 

Insert a video 

2 
 

 

Insert an audio 

 

 Design Tab 
 

 
 

Page Setup 

1 
 

 

Set the page setup to portrait or landscape 

2 

 

Sets the slide orientation as portrait /Landscape 

Themes 

3 

 
 Change the design theme 

 

 

Background 

1  

 

Set Background Styles 

2 
 

Hide Background Graphics 



 

 

 Transition Tab 

Used to set the transition of the power point presentation 
 

Preview 

1 
 

 

Used to preview the transitions 

Transition to this slide 

Subtle 

1 

 

Sets the transition to none 

2 

 

Sets the transition to cut 

3 
 

 

Sets the transition to fade 

4 
 

 

Sets the transition to push 

5 
 

 

Sets the transition to wipe 

6 
 

 

Sets the transition to split 

7 

 

Sets the transition to reveal 

8 

 

Sets the transition to Random Bars 

9 
 

 

Sets the transition to shape 

10 
 

 

Sets the transition to uncover 

12 
 

 

Sets the transition to cover 

13 
 

 

Sets the transition to flash 



 

Exciting 

1 

 

Sets the transition to dissolve 

2 

 

Sets the transition to Checkerboard 

3 
 

 

Sets the transition to Blinds 

4 

 

Sets the transition to clock 

5 

 

Sets the transition to Ripple 

6 

 

Sets the transition to Honeycomb 

7 

 

Sets the transition to Glitter 

8 

 

Sets the transition to Vortex 

9 

 

Sets the transition to Shred 

10 

 

Sets the transition to switch 

11 

 

Sets the transition to Flip 

12 

 

Sets the transition to Gallery 

13 

 

Sets the transition to Cube 

14 

 

Sets the transition to Doors 

15 

 

Sets the transition to Box 

16 

 

Sets the transition to zoom 



 

17 

 

Sets the transition to Pan 

18 

 

Sets the transition to Ferns Wheel 

19 

 

Sets the transition to Conveyor 

20 

 

Sets the transition to rotate 

21 

 

Sets the transition to window 

22 
 

 

Sets the effect options to horizontal 

and vertical 

Timing 

1 
 

Add a sound to the power point file 

2 
 

How long the sound will remain 

3 
 

Apply effect to all slides 

4 
 

 
Run effect on mouse click 

5 
 

Effect takes place after certain number 
of seconds 



 

 Animation Tab 

The Animation tab is used to induce animation to a particular slide or all slides 



 

 Slide show Tab 
 

1 

 

Slide show from the beginning of the power 

point 

2 
 

 

Slide show from the current slide 

3 
 

 

Broadcast Slide Show so that it can be viewed 

by remote users who can watch in a web 

browser 

4 
 

 

Create or play a custom slide show . A 

custom slide show only display the slides that 

you want to display 

5 
 

 

Sets up slide show. 

6 
 

 

Hide the current slide from presentation 

7 
 

 

Set timings for each slide 

8 
 

 

Record Slide show. 

9  Play back audio narrations and audio pointer 
gestures during slide show. 

10 
 

 
Play back slide and animation timings during 

slide show. You can record slide and 

animation timings using rehearse timings and 

slide show 

11 
 

Show play control when you move the 

pointer over audio and video clips during the 

slide show 

12  Change resolution of the image. 

13  Choose a monitor on which to display the 

full screen slide show. 

If you are using a monitor or are using a 

laptop without an external monitor attached 

this command is disabled. 



 

14 
 

Show the full screen slide show using 

presenter view. This view allows you to 

project the full screen slide view to one 

monitor that includes timings and speaker 

notes. This feature requires multiple monitors 

or a laptop with dual display capabilities. 
 
 

 Review Tab 
 

 

1 

 

Checks the spelling of the 

text in the power point 

presentation and corrects the 

spelling. 

2 

 

Open the research task pane 

to search through reference 

materials such as 

dictionaries, encyclopedias 

and translation 

Services. 

3 
 

 

Suggests other words with 

the similar meaning to the 

word you have selected 

4 
 

 

Translate a selected text to 

another language. 

5 
 

 

Select Language Options 

6 

 

This option is used to add a 

new comment to a Power 

point presentation. 

7 
 

 

Edit comment 

8 
 

 

Delete comment 

9 
 

 

Previous comment 



 

10 
 

 

Next comment 

11 
 

 

Compare and combine 

another presentation with 

the current presentation. 

12 
 

 

Click this button to access 

other options such as 

accepting other changes in 

the document. 

13 

 

Click this button to access 

other options such as 

rejecting other changes in 

the document. 

14  

 

Navigate to the previous 

revision of the document so 

that you can accept or reject 

it. 

15  

 

Navigate to the next revision 

of the document so that you 

can accept it or reject it. 

16 
 

Show reviewing pane when 
reviewing changes 

17 

 

End review 

 
 

 View Tab 
 

 
1 

 

 
Normal format 

2   
Slide sorter 

3  
View notes page to edit the speaker notes 

as they look when they print them out. 

4 

 

View the presentation as a slide show that 

fits within the window. 



 

5 
 

 

Open slide master to change the design and 

layout of the master slides 

6 
 

 

Open hand out master view to change the 

design and layout of printed layouts 

7 
 

 

Open Notes master. 

8 
 

 View the rulers used to measure and line 
up objects in the document 

9 
 

 
Turn on gridlines to which you can align 
objects in the document 

10 
 

Show adjusted drawing guides to which you 
can align objects on the side. 

11 
 

 

Show the Zoom control dialogue to specify 

the zoom level of the document. 

 

12 

 

 
Zoom the slide so that it fills the Window. 

18 
 

View the presentation in colour mode 

19 
 

 
View the presentation in gray scale mode 

20 
 

View the presentation in Black and White 

21 
 

 

View the current presentation in a new 

window 

22 
 

 

Tile all open program windows side by side 
on the screen 

23  

 
Cascade the open document windows on the 
screen so that they overlap. 

24  
 

 

Move the splitters which separate the 

different sections of the window. 

After checking this button use the arrow 

keys to move the splitters and then press 

enter to return to the document. 

25 

 

Switch to a different currently open 

Window 



 

26  

 

 

Create ,view, run, delete a macro. 

 
 

 Format Tab 
 

1 

 

 

Used to insert and 

edit shape, add text 

box 

2 

 

 

 
Shape Styles 

3 

 

 
 

Word Art Styles 

4 

 

 
Arrange 

5 

 

 
 

Size 

 
 

 

 Let us sum up 
 

 

In this unit we have learnt what is Power point and how it is a powerful tool to describe a person’s ideas 

in front of many. Microsoft PowerPoint presentations can be distributed via internet and via pen drives 

and other secondary storage devices. We have discussed the various tools that are used in this software. 

They are broadly classified into 10 tabs. These are file, home, insert, design, transition, animation, Slide 

show , review, view and format tab .These tabs have a specific role and specific functionality for the 

preparation of power point presentation. Use of power point quickened the speed of presentations than 

the plastic sheets which were very costly, laborious to prepare in the yester years. 
 



 

 

Unit -2 

Working with textboxes and slides 
 

 
 

Learning objectives 
 

After the Completion of this unit you should be able to know 
 

1. What is a textbox and how it can be incorporated on the slide 

2. What is a slide and its manipulation? 

3. What is a slide note and how it is used? 

4. What is a side bar and why it is used? 

5. The components of the side bar which are the slide section and outline 

section 

6. What is a slide section and how it is used? 

7. What is an outline and how it is used? 
 

 

 Introduction 
 

After knowing the tools this is the half way of our learning. We should know 

how to be smart in power point. This comes after we know working with 

textboxes which are vitally required for entering data into the presentation. 

Working with slides involves slide adding, deleting, modifying and sorting. 

Slides those that are prepared by a person may not be understood by another 

person. At this time the slide note comes to use which describes what for the 

slide was prepared. Slides those that are prepared need immediate textual 

verification. In such cases we work with outline. At   times the PowerPoint can 

be very large. Example of large presentations involve presentations of 

organizations such as schools, colleges, universities, hospitals where 

departments are many. In such cases we take the help of sections. With this we 

summarize and close the unit. 
 

Definitions 

Textbox: - Textbox is a tool used to write text on a power point slide. It also 

acts as a placeholder to hold text where it is dragged and placed. The textbox 

can be rotated at any degree according the need of the user. 

Slide :- A slide is a single page of a presentation created with software 

such as PowerPoint 

Outline :-   Outline View shows all the text of all slides in the presentation, 

in PowerPoint. This view is useful for editing purposes and can be exported 

out as a Word document to use as a summary handout. 



 

Section:- A feature of power point software so that slides can be 

organized in a particular fashion for easy understanding and quick review. 
 

Working with textboxes 

Power point allows users to add text to the Power point presentation. 

4 types of textboxes are there 

1. Title Textbox 

2. Subtitle Textbox 

3. Content Textbox 

4. Text Only Box 

 Working with title and subtitle textboxes 

 

 

Title textbox :- This option allows the user to add title to the slide 

which may be the topic of the presentation 

Sub title textbox :-This option allows the user to add subtitle to the slide 

which includes Created by author and author credentials. 

 Working with content textboxes 
 

 



 

 

This option allows the user to add 
 

1. Text 

2. Graphs 

3. Smart art 

4. Pictures 

5. Clip arts 

6. Videos 

 

 Working with  text only  box 
 

Click On Insert Tab and then click on Textbox icon as shown below 

 

 

 

This option is used to add text to the slide. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Working with slides 
 
 

 Add a new slide 
 
 

Step-1 
 

 
 

Step-2 
 

 

 Delete a new slide 
 

To Delete a slide right click on the slide shown on the left pane 

as shown below 



 

 
 

Click the delete button. 
 

 Edit a slide 

 



 

 Rearranging slides 
 
 

Slide-1 
 

Slide-2 
 

Add A New Slide 
 



 

Slide-3 
 

Step-4 
 

Suppose you want to swap slide 2 to slide 1 click the slide2 and pull it 

upward and place it 1 position 

 



 

 Importing slides 
 

This option is used when you want import slides from presentation 2 

to  presentation 1 

Step -1 
 

Let us consider the presentation presentation-1 as shown below 
 

Step-2 
 

Let us consider the presentation presentation-2 as shown below 
 

Step-3 
 

Now to include the slides of presentation 2 into presentation1 

You select the slides of  presentation 2 

For continuous slides like 1,2,3 
 

1. click on view and slide sorter 

2. click on first slide and then click shift + left mouse click the 

second slide 

3. click on copy 



 

4. open presentation1 

5. click below the slide where you want to insert 

6. click paste 
 

For non-continuous slides like 1,3,5 
 

1. click on view and slide sorter 

2. click on first slide and then click ctrl + left mouse click the 

second slide 

3. click on copy 

4. open presentation1 

5. click below the slide where you want to insert 

6. click paste 
 

 

 Working with slide notes 
 
 

 What are slide notes 

Slides notes is a powerful tool to store the notes of the slide which is 

prepared. These Notes are not visible during the Power point presentation 

but can be printed along with the slides so that the presenter can know 

in detail about each slide in the notes and accordingly deliver lecture. 

 How to prepare slide notes 
 
 

Step-1 

 



 

Step-2 
 

 
Step-3 

 

 
Advantages of slide notes 

It helps the presenter to store notes for each slide that he/she prepares and it 

helps in presenting large presentations which need heavy documentation . 



 

 

 Working with side bar 
 

 

As discussed the sidebar is used to 
 

1. Insert a new slide anywhere in the presentation. 

2. Delete the slide anywhere in the presentation 

3. Insert slides from other power point files into this presentation 

4. Break Power point presentation into many sections. 

5. This feature is comprised of 2 features namely slide view and 

outline view which we shall be discussing shortly 

Manage sections which involve creation, deletion, renaming, moving 

up and down the sections and slides. 
 

 Working with sections 

 What is slide section 

Slide section is used when working with very large presentations. Suppose the presentation is a 

very large presentation and this presentation can be done by 10 people for 10 parts of the 

presentation. In such cases 10 people work separately on various parts. Finally all parts are 

integrated into 1 power point presentation as sections. 

 

Managing slide section 



 

 Adding slide sections at the end of the presentation 
 
 

Step-1 

 
Step-2 



 

 Renaming the sections of the presentation 
 
 

Step-1 
 

 
Step-2 

Step-3 

 



 

 Breaking slide presentation into various sections 
 

Step -1 
 

 
Step-2 

 
 



 

Step-3 
 

 
Step-4 

 



 

Step-5 

 
 

 Removing slide section from a presentation 
 

Step-1 



 

 Removing slide sections and slides from a presentation Step-1 
 

Right click on the section to be deleted 
 

 

 
Step-2 

 



 

 Removing all slide sections from a presentation Step-1:- 

Right click on a section and select remove all sections 

 

 

 Moving sections up/down Step-1 

Select the section with left mouse click and move it upwards. 
 
 



 

Step-2 
 

 

 Working with outlines 
 

This option is used when a presenter wishes to see all the textual part 

rather than the textual part and the graphical part. 

 

 



 

 

Unit -3 

Features of Power Point {Part -1} 
 

 
 

Learning objectives 
 

After the Completion of this unit you should be able to know 
 

1. What is a view and what are various kinds of views in Power Point 

2. Cut and paste operations in PowerPoint 

3. Copy and paste operations in PowerPoint 

4. Content translation 

5. Set language type 

6. Duplicating content 

7. Using special characters on the slide 
 

 

 Introduction 
 

We have covered so far about the power point presentation in the earlier units .In 

this unit we shall be working on some features which would help us work faster 

and in an elegant fashion. We shall be discussing about the various views of the 

power point, editing a presentation which involves changing the background, 

style ,fonts so that the presentation looks attractive, adding new language such as 

Hindi in the existing presentation, duplicating content which is a feature to 

reduce retyping in order to prepare a new slide. The use of special characters 

helps us to incorporate special characters onto the presentation. 

 Definitions 

Views :- The views in Microsoft PowerPoint 2010 is a feature that is used to 

edit, print, and deliver your presentation 

Presentation Background:- A feature in power point by which the background of 

the presentation can be changed for a single slide and all slides. 

Views in PowerPoint 
 

 Presentation view is of 4 types 
 

 



 

 

 

 

 Normal view 
 

This is a default view to 

a) Add 

b) Edit 

c) Delete 

d) Change slide order 

 

 
 

 

 Slide sorter view 
 

This option is used to 

a) Change the order of the slides 

b) Add Slides 

c) Edit Slide delete the slides seen 

d) Add sections 

e) Remove sections 

f) Rename Sections 

g) Move sections 
 



 

 Reading view 

  

This option is used to read the power point presentation as if were a presentation view with an exception 

that in power point presentation the entire screen is taken up by the slide but in this case the task bar is 

seen. 

 

 

 
 

 

 

 Slide show view 
 

 

 

The slide show view is used to run the slide show of the power point 

presentations. This option is used to run the presentation and show to the 

audience. 
 

 Setting presentation background 

This option is used to change the presentation background of the slide. This 

option is activated by going ro the Design Option 

1. Changing the themes of the presentation 

2. Changing the colours 

3. Changing the fonts 

4. Changing the effects 



 

5. Changing the Background Styles 

6. Hide Background Graphics 

Setting presentation background by changing the themes of the 

presentation 
 

 
ORIGINAL SLIDE 

 

ADD ATHEME TO THE SLIDE 
 

 

 



 

 Setting presentation background by changing colors 
 

 

 
 

 

 



 

 Setting presentation background by changing fonts 
 

 



 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Setting presentation background by changing background style 



 

 

 

 

 

 

 Setting presentation background by hiding background graphics 
 

 

 

 

 



 

 Setting presentation background by changing format background 
 

 

 

 

 

 



 

 
 

 Cut and paste operations 
 

Cut and paste operation is used to remove a content at a particular 

location of a slide of a presentation and paste it in 

1. Same slide of the same presentation 

2. Another location of a different slide of the same presentation 

3. Another location of slide of different presentation 
 

 How to cut and paste Step-1 
 

Prepare a new slide in a new presentation 
 

 

 

 
Select How From the title in the slide 

Step-2 

Step-3 

Click on the Cut option which is under the Home Tab as shown 

below 

 
Step-4 

Once the cut option is clicked How is cut from the screen and 

available in the memory 

 



 

Step-5 

 The 4 options of pasteing 

 
Image Document 

 

Use Destination Theme 

 
Keep Source Formatting 

 
Paste As Picture 

 

Keep Text Only 

 

 

 



 

This option is used to save the cut text in 

1. HTML {Hyper Text Markup 

Language} 

This option allows you store 

the text in Hyper Text 

Markup Language 

2. Picture(GIF) Store the copied text in a 
image format 

3. Picture(JPEG) Store the copied text in a 
picture format 

4. Device Independent Bitmap Store the copied text in a 
device independent bitmap 

5. Bitmap Store the copied text in a 
bitmap 

6. Picture Enhanced Meta File Store the copied text in 
Picture Enhanced Meta File 

7. Picture Windows MetaFile Store the copied text in a 
Picture Windows MetaFile 

8.  Formatted Text Store the copied  text in a 
formatted text 

9. Unformatted Text Store the copied text in a 
unformatted text 

 

 

 Copy and paste operations 
 

Copy and paste operation is used to copy a content at a particular 

location of a slide of a presentation and paste it in 

1. Same slide of the same presentation 

2. Another location of a different slide of the same 

presentation 

3. Another location of slide of different presentation 



 

3.6.1  How to Copy and paste 
 
 

Step-1 

 

 

 

 

 

 

 

 

 

 

 
Step-2 

 

 

 

 

 

 
Step-3 

 

 

 

 
 

Step-4 

 

 
Prepare a new slide in a new presentation 

 

 

 

 
Select How From the title in the slide 

 

 

 

 

 
Click on the Copy option which is under the Home Tab as shown 

below 
 

 

 

 

Once the copy option is clicked How is cut from the screen and 

available in the memory 

 

 

 

 

 

 



 

Step-5 
 

 
The Paste has 4 options as shown above 

Image Document 

 

Use Destination Theme 

 
Keep Source Formatting 

 
Paste As Picture 

 

Keep Text Only 

 

 

 
 

 

 

This option is used to save the cut text in 

1. HTML {Hyper Text Markup 
Language} 

This option allows you store the text 
in Hyper Text Markup Language 

2. Picture(GIF) Store the cut text in a image format 

3.Picture(JPEG) Store the cut text in a picture format 

4. Device Independent Bitmap Store the cut text in a device 
independent bitmap 

5. Bitmap Store the cut text in a bitmap 

6. Picture Enhanced Meta File Store the cut text in Picture 
Enhanced Meta File 

7.Picture Windows MetaFile Store the cut text in a Picture 
Windows MetaFile 

8.Formatted Text Store the cut text in a formatted text 

9.Unformatted Text Store the cut text in a unformatted 
text 



 

 Find and replace 

The Find and Replace Operation is used to find the text in a presentation 

and replace it with another text in the presentation. 

 
 

 

 Find what :- what is the text you want to find 

 Match case :- Match the case as how it is written in the text 

box 

 Find whole words Only :- The document is scanned to find 

words How 

 Find Next :- Used to find the next occurrence of the word 

How 

 Close :- This closes the existing find operation 

 Replace :- Used To replace the found text with another text 
 

 Replace With :- Replaces the found text with another text 

 Replace All :- Replaces all the found text How with 

Where 



 

 

 Content translation 
 

This option is used to translate the content to some other language such as 

English to Hindi. 

Step-1 
 

Select a by left clicking and dragging your mouse. 
 

 
Step-2 

 

Now Right Click and the screen is shown below. Click on Translate 
 



 

Step-3 
 

 

Step-4 

 

 

Step-5 

 

 
Click on the Insert Button To insert the translation 

 

 

 

Above the word you is translated to Hindi and Shown. 



 

 

 
 

 Set Language type 
 

 
 

Step-1 
 

Click on Review ->Language ->Language Preferences 
 



 

 

Step-2 :- To Add A Default Language 
 

 

 

 

 
 

Step-3 

Select the language to be added and click on Add button to add a 

language 

 

Click on Set as default to set the language as the default and 

remove button to remove the language from the list. Click on Ok 

button to confirm . 

Warning :- The contents of the entire power point will be 

changed. 



 

 

 Duplicating content 
 

Duplicating a content can be done in 3 ways 
 

1. Cut and Paste :- Already described earlier. 

2. Copy and Paste :-Already described earlier. 

3. Duplicate a slide :- this is done by right clicking the slide and 

click duplicate slide as shown below. 

 
Step-1 

Step-2 
 



 

 

 Special characters 
 

To insert special characters to the Power point presentation click on insert and 

then click  on  symbol as shown below. 

Step-1 
 

Step-2 
 



 

Step-3 
 

 

 



 

 

Unit -4 

Features of Power Point {Part -2} 
 

 
 

Learning objectives 
 

After the Completion of this unit you should be able to know 
 

1. Zoom in and zoom out a PowerPoint presentation 

2. Font management 

3. Text decoration 

4. Paragraph indentation 

5. Set line spacing between 2 lines of a text 

6. Borders and shading 

7. How to create a design template 

8. How to work with pictures 

9. Working with shapes on a slide 

10. Adding audio and video to a slide 

11. Working with charts on a slide 
 

 
 

 Introduction 
 

We have covered so far about the power point presentation in the earlier units .In 

this unit we shall be working on some features which would help us work faster 

and in an elegant fashion. We shall be discussing about the following topics 

slides zoom in out, font management, text directions, paragraph indentation, set 

line spacing, borders and shading, creating a design template, managing a 

picture on a slide, working with shapes on a slide, adding audio and video to a 

slide, adding charts to a slide. 
 

 Definitions 

Zoom in out :- A feature given in PowerPoint to zoom in and zoom out a side. 

Font management :- A feature used to manage the font type, size 

Text decoration :- A feature used to change the decoration of text 
 

Paragraph indentation:- A feature of PowerPoint to change the indentation of a 

paragraph 

Set line spacing:- A feature to set the spacing between the lines in a textbox. 

Border:- A feature to set the border of a drawn shape or  a textbox. 



 

Design template :- A format designed by the user so that it could be used in 

other presentations. 
 

Slides zoom in out 
 

The zoom in and out is as shown below clicking on + symbol magnifies 

the slide and clicking on – symbol minimizes the slide projection. 
 

 
 
 
 

 

 Font management 
 

Font management is used to change the fonts of the power point text. This is 

done by font type and font size as shown below .the font size can be increased 

or decreased and so the font type can be changed 

 

Text decoration 

The text can be decorated in the following ways 
 

 
To make the text Bold 

 To make the text italized 

 To make the text underlined 
 

 To strike through the text 

 
To create a subscript of the text 

 
To create a superscript of the text 

 
To create a text effects 

 
To create a text highlighter 

 
To change the font colour 

 

 
To clear formatting from the selection 

 Change to Sentence Case 



 

 
 

Change to Lower Case 

Change to Upper Case 

Change to Capitalize Each Word 

Change to Toggle Case 

 
 
 

 
 
 

 Paragraph indentation 
 

Paragraph can be indented in 4 ways 
 

 
 

 
Left Align 

 
Center Align 

 
Right Align 

 
Justify 

 

 

 Set line spacing 
 

 
 

To set the line spacing in a power point select the paragraph and sent the line 

spacing tool under the home tab as shown  below 

 
 



 

 

 
 

 Borders and shading 
 

Borders and shading is used to change the look and feel of the 
 

1. Table 

2. Drawing 
 

Table Step-

1 
 

Click the insert tab and click on table button as shown below 
 

Step-2 
 

Step-3 
 

Select the table as shown below by left clicking and dragging as 

shown below 



 

 
 

Step-4 

 

Change the borders and shading with the options given below 
 

Step-5 
 

Modified borders and shading 
 
 



 

 Borders and shading of shapes 

 

 
Borders and shading of shapes is done by 4 methods 

1. Quick styles 

2. Shape Fill 

3. Shape Outline 

4. Shape Effects 

 
 

 Quick styles 

Step-1 

 
Draw a shape as shown below 

 

Step-2 
 

Using the Quick Styles 



 

 

Step-3 
 

 
 

 Shape fill 

 

 

Step-1 

 

Step-2 



 

Use the shape fill to fill the shape. 

You can  fill it with 

1. Colors 

2. Pictures 

3. Gradient 

4. Texture 

 

 Shape fill with colors 

 

 Shape fill with pictures 

 
 

 Shape fill with change in gradient 

 



 

 Shape fill with change in texture 

 Shape outline 

This option is used to change the shape outline of the shape 
 

 
This is done in 4 ways 

1. Changing outline colors 

2. Changing the weight of the shape 

3. Dashes 

4. Arrows 



 

 Shape outline with changing outline colors 

 
 

 Shape outline with changing the weight of the shape 

 

 

 
 Dashes 

 



 

 Arrows 

This option is used in case of lines that you draw using the shape tool 
 

Step-1 
 

Using the Arrow effect on the line 
 
 

 

Step-2 

 

 

 Using slide master to create design template 

This option enables you to create your own theme for the presentation instead of 

depending on Power point default themes to make your presentation colourful 

and lively .The simple way to make changes to different sections of the slide is 

by using Slide Master. 

Step-1 

Click on View an click on Slide Master an select one of the slides on 

the left to prepare the slide theme 

 

 

 

 

 

 

 

 

 

 

 

 

 
Step-2 

 

Click on the Format option and select the effects that you ant to add. Here for 

simple understanding I use Shape Fill. 



 

 
 

Step-3 

Now to save the theme follow the following steps as below 
 

1. Click on slide master and click themes 

2. Click on save current theme as show below 
 



 

 
 

3. Give a name to theme and click save 
 

4. Close the entire presentation without saving 
 

5. Now create a new power point presentation 
 

6. Go to design and you find the theme is in your name as shown 

below 

 
 



 

 

 
 

 Manage a picture on a slide 
 

 Add a picture 

To add a picture into a power point click on insert picture. 
 

 Edit a picture 
 

To edit the picture follow the following steps 
 
 

 

 
Removes the background from the image 

 

 

Correction such as brightness and contrast, sharpen 

and soften theimage 

 

 
Change the colour of the image 

 

 

 
Bring artistic effects to the image 

 

 Compress the picture 

 
Change the picture with a new one 

 

This option is used to undo all changes made to the 
picture 

 

This option is used to change the picture style 

 
Used to change the picture border 

 

 
Used to change the picture effects 

 

 

Use when multiple pictures are on a 

slide and one picture is to come 

forward and other picture has to be 

sent behind 

 

 

Used to send the current picture 

backward and the picture behind 

forward. 



 

 

 

 

 

 

 

 

 
Align selected images 

 
Group 2 images so that they are 
treated as one 

 
Used to ungroup grouped images 
into individual ones 

 

 

 

 
Rotate an image 

 

 
Crop an image from slide 

 

Set the height and width of the 

image 



 

Delete a picture 
 

To delete a picture select and press the delete key 

 

 Working with screenshots on a slide 
 

The screen shot is used to explain the process step wise in a computer. 

For example if I want to add a screenshot about the Windows 7 

computer screen I follow the following steps 

 

Step-1 
 

 

 

 

Click which is under insert menu 
 

Step-2 
 

Click screen clipping and drag it across the slide as shown below 
 

 



 

 

 Working with shapes on a slide 
 

 
 

 Shape insertion 
 
 

This option is used to insert shape on slide 

Click on Insert Tab and Go for shapes as shown below 

Step-1 

 



 

Step-2 

Choose a shape and drag the mouse with left click pressed 
 

 
 Shape alteration 

 

To alter the above shape follow the following steps 

Step-1 

Click on format 

Click on the shape and click  

Step-2 

Click on 

1. Change Shape to change the shape 

2. Edit points to completely modify the shape of the image 
 

 Change Shape 
 

 
 



 

 Edit points 

 

 

 
 Shape formatting 

 

To format the shape click on format tab and format the shape as per 

your liking 

 

 
 

 Shape deleting 
 
 

To delete the shape select the shape and press the Delete key 
 

 Arranging shapes and pictures on a slide 

Select the shapes and pictures on the slide and click on Format tab 

and then click Align or you can select an image of shape with your 

mouse left click and drag it where you want to place it. 

 

 Adding audio and video to a slide 
 

 
 

To add a Audio and video select the slide where you want to insert 

audio and click insert and 

 



 

To add a video 

And 

 
 

To add audio 
 

 

 

 Working with charts on a slide 
 
 

 Inserting charts 
 
 

To insert a chart on a slide do the following 
 

Step-1 
 

Click on Insert Tab and Select the chart button as shown below 
 

Step-2 
 

Select the type of chart you wish to insert and left mouse Click 



 

 
 

And click OK Button 
 

 

Step -3 
 

 
 



 

 Modifying charts 
 

 

 

 
 

Click on under Design 
 

 

 

 

 
 Deleting charts 

To delete a chart select the chart and press the Delete button 
 

Check your progress 
 
 

1. What are the ways to decorate a text? 

2.What is the way to indent a paragraph? 



 

 

Unit -5 

Sharing Presentation 
 

 
 

Learning objectives 
 

After the Completion of this unit you should be able to know 
 

1. How to convert a power point to PDF 

2. How to convert a power point to video 

3. How to create an image from power point 

4. How to print a power point 

5. How to broadcast a Power point presentation 
 

 

 Introduction 
 

Presentation of an author is his sole property.at times these presentations are 

taken by some others and they make a fortune out of it. He/she may like to share 

it another form except the power point presentation form. Here Power point 

comes as a handy tool which can be used to convert from power point 

presentation format to PDF, image, video, print , broadcast.So we shall be 

learning how to do all the above by few clicks of a mouse button 

 Definitions 

Sharing a presentation is a process to convert from existing power point 

presentation to other formats basing on the needs and requirements of the user 

 Convert a Power point to Pdf 

Step-1 

Open the power point presentation 
 



 

 

Step-2 
 

Enter the new name of the file and enter save as type as PDF 
 

Step-3 
 

Click on the save button 
 

 

Convert a Power point to video 

Repeat the earlier step 1 in 5.3 

Enter the new name of the file and enter save as type as Windows Media Video 
 

Click on the save button 
 

Convert a Power point to image 

Repeat the earlier step 1 in 5.3 

Click on the save button 
 

Enter the new name of the file and enter save as type as JPEG format 
 

 

 Print a power point 

To Print a Power point presentation select file and print as shown below. 
 



 

 

 Broadcast a power point 
 

This option is used to broadcast a power point presentation by means of 

internet. 

Step-1 
 

Click on Slide show and click on Broadcast Slide Show as shown below 
 

Step-2 
 

Step-3 
 

Click on start broadcast. Enter your credentials to broadcast to other emails 
 

 
 

 

 . 
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